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关于 i-Tree（About i-Tree） 

i-Tree是来自美国林务局最先进的同侪评阅（peer-reviewed）软件套件，其提供

都市及小区林业分析与效益评估工具。i-Tree 工具藉由量化环境树木提供的服

务及评估都市林结构，以帮助各种大小的地区加强他们的都市林管理与推广

度。 

 

i-Tree已被小区、非营利组织、顾问、志工及学生用于记录各种规模的都市

林，从单一树木乃至小区、都市甚至整个国家。透过了解当地树木实际提供的

生态系服务，i-Tree使用者可连结都市林管理活动、环境质量及小区的可居住

性。无论研究目标为单一树木或整个森林，i-Tree的基础数据供你证明价值及

确定优先度以做更有效的决策。 

 

由美国林务局与众多合作伙伴共同开发，i-Tree设于公共网域上，可向 i-Tree网

站（www.itreetools.org）索取授权。林务局、Davey树木专家公司（Davey Tree 

Expert Company）、植树节基金会（Arbor Day Foundation）、市植树师学会

（Society of Municipal Arborists）、国际树艺协会（International Society of 

Arboriculture）以及 Casey Trees 皆已成为合作伙伴以利未来发展、传播与为此

套件提供技术支持。 

 

i-Tree产品（i-Tree Products） 

i-Tree软件套件 5.0版本包含以下各都市林分析工具及应用程序。 

 

i-Tree Eco 提供整个都市林的概况。其使用来自小区随机分布样区的现场数据

及当地每小时空气污染和气象数据，以量化都市林结构、环境影响与对小区的

价值。 

 

i-Tree Streets侧重于生态系服务及一个都市行道树族群的结构。它使用一个样

本或完整普查量化并将每棵树的年度环境与美学效益以美元价格计算，包含节

约能源、改善空气质量、减少二氧化碳、雨水控制及房地价增幅。 

 

i-Tree Hydro 是第一个针对植被的都市水文模型。其模拟都市林覆盖变更的影

响，及流域层不透水表面的每小时河流流量和水质。 

 

i-Tree Vue让你自由使用全国土地覆盖数据库（National Land Cover Database，

NLCD）的卫星图像以评估小区的土地覆盖，包含树冠及当前都市林提供的一

些生态系服务。其也可模拟种植方案对未来效益的影响。 

 

i-Tree Species Selector 是一个独立的工具，用于帮助都市林管理者根据环境功

能和地理区域选择最适合的树种。 
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i-Tree Storm帮助你在一场严重的飓风天灾过后，立即以简单、可靠又有效的

方式评估广泛的小区损害。它适用于各种小区类型及大小，并提供关于时间与

减轻灾害所需资金的信息。 

 

i-Tree Design 是一个简易的在线工具，提供一片树林中单一树木的评估平台。

此工具连接 Google地图，使你了解树木选择、树木大小及放置位置将如何影响

能源使用和其它效益。此工具仍在早期开发阶段，更多精密的功能选项会在未

来版本释出。 

 

i-Tree Canopy 提供一个快速简便的方法，透过使用适合的 Google Maps 航空图

像，产生土地覆盖类型（如，树木冠盖）的有效统计性的估计。透过使用这些

数据，城市森林管理者可估计树冠覆盖、设立树冠目标，及顺利地进行追踪，

且能为 i-Tree Hydro和其它需要土地覆盖数据的项目估计所需数值。 

 

免责声明（Disclaimer） 

本出版物中所使用之商品、商号或公司名称仅为提供读者信息和便利，并非排

除其它可能适合之任何产品或服务的使用方式，所提及之商品、商号或公司名

称也非受到美国农业部或林务局的官方认可或批准。标签「i-Tree Software Suite 

v. 5.0」所发布之软件，将不提供任何形式的担保。它的使用受到最终用户许可

协议（End User License Agreement，EULA）管辖，使用者在安装前需先同意接

受该协议。 

 

回馈（Feedback） 

i-Tree开发团队积极寻求关于此产品的任何回馈意见：软件套件、使用手册，

或是开发、推广、支持和精细化的过程。请将评论根据 i-Tree支持页面所列出

的方式寄送：http://www.itreetools.org/support/ 

  

http://www.itreetools.org/support/
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介绍（Introduction） 

i-Tree Storm 是以风暴灾害评估程序工具（Storm Damage Assessment Protocol 

Utility）为基础，建立一套标准方法，以简单、可靠、高效率的方式，在一场

剧烈风暴后立即评估广泛的灾害。此评估方法适用于各种小区类型和大小，并

提供减轻风暴破坏所需的时间和资金信息。 

 

样本街道区段将从小区中随机选取，并进行调查，时间和成本估计皆会被记

录。一个 MS Excel 所开发的模板可执行所有计算，估计减轻灾害的成本及整个

小区的残骸清理费用。PDA应用程序有助于数据收集，选择或需要手动完成工

作的使用者则可使用纸制表格。 

 

该协议包括评估小区行道树的自选风暴前阶段，针对严重风暴后所需的清理成

本，提供一个粗略的估算。一个特别的风暴调整试用版（Hurricane Adaptation 

(beta)）模型能利用历史数据以改善这类风暴的估计。这个版本仍在开发中，请

踊跃提供回馈。 

 

有关 Storm 模型的更多信息，请参考 i-tree网站（www.itreetools.org）Resources

中「An Initial Storm Damage Assessment Protocol for Urban and Community 

Forests」。 

 

关于本手册（About This Manual） 

本手册将提供进行 Storm 项目所需的所有信息。我们从安装软件开始，之后会

介绍四个项目阶段： 

 

第一阶段：准备（Phase I: Getting Prepared）：在本节中，我们会讨论一开始

需做出的决策，比如，如何、何时以及那些数据将被收集。第一阶段也包含针

对一般意外准备的有用指示，包括计划的沟通、人员、备份及存储。在这个阶

段，你也会收集一般资料，如紧急工作人员的成本估算。最后，你将创建随机

样本并为数据收集准备 PDA或手动表格。 

 

第二阶段：风暴前（Phase II: Before the Storm）：若欲针对你的样本进行风暴

前调查，在本节中，我们将解释需收集哪些数据及如何使用 PDA或表格工作。

收集数据后，你将传送数据到桌面上，回答一些设置问题，及查看分析结果。 

 

第三阶段：风暴后（Phase III: After a Storm）：本节将介绍风暴后需要收集的

数据，并叙述如何使用 PDA和表格工作。收集数据后，你将传送数据到桌面

上，回答一些设置问题，及查看分析结果。 

 

附录一：随机抽样工作书（Appendix I：Random Sample Workbook）： 〈附



7 

录一〉提供使用 ArcGIS 软件产生随机样区的其中一种方法的步骤。 

 

附录二：数据表单（风暴）（Appendix 2: Data Forms (Storm)）：进行常规

Storm 分析的所有表格皆收录于此。 

 

附录三：数据表单（飓风调整）（Appendix 3: Data Forms (Hurricane 

Adaptation)）：进行飓风调整版本的所有表格皆收录于此。 
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安装（Installation） 

 

系统要求（System Requirements） 

桌上型/笔记本电脑的需求（Desktop/laptop computer requirements） 

最低硬件（Minimum hardware）： 

 Pentium 或 1600 MHZ 或更快的处理器 

 512 MB可用内存 

 至少 500MB的可用硬盘空间 

 显示器分辨率要 800 x 600或更佳 

 

软件（Software）： 

 Windows 操作系统 XP SP2或更高（包含Windows 7） 

 Microsoft Excel 

 针对 PDA使用者，Windows XP 需 ActiveSync 4.5 或更高版本，Vista和

Windows 7 需Mobile Device Center 6.0 或更高版本（包含在 i-Tree安装

内） 

 

实地数据收集仪器的需求（Requirements for field data collection devices） 

几种智能型手机和 PDA设备可与 i-Tree应用程序一起使用。具备下列基本规格

的设备，拥有使用 i-Tree应用程序的最佳性能和兼容性： 

 Windows Mobile 5.0–6.5操作系统（OS7 目前无法兼容） 

 最低屏幕分辨率 240 x 320；640 x 480 最佳。 

 

安装（Installation） 

安装 Storm： 

1) 进入此网站（www.itreetools.org）下载软件，或将 i-Tree软件安装光盘放

入 CD/DVD光驱中。 

2) 按照屏幕的指示执行 i-Tree setup.exe档案。根据所需的安装档案不同，

这将花几分钟的时间。 

3) 按照安装小精灵的指示以完成安装（建议安装在默认路径）。 

 

你可以藉由点击 Help > Check for Updates 随时检查最新的更新。 

 

构件（Components） 

安装包包含三个 Storm 构件：Excel 模板、PDA应用程序，以及链接这两个工

具的接口。PDA应用程序可使用 PDA执行，其为专门设计用以收集 Storm 数

据的工具。Excel 模板应于桌机执行，其使用编制期收集的数据，估算关于你小

区在风暴中的全部损失。接口则能传输你的随机样本数据到 PDA，且在资料收

http://www.itreetools.org/
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集后，从 PDA转移资料到模板中。若你不使用 GIS 创建你的随机样本，使用

接口手动输入你的样区信息是最简单的。 
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第一阶段：准备（Phase I: Getting Prepared） 

 

一般应急计划（General Emergency Planning） 

i-Tree Storm 属于一般范围内的小区紧急计划和紧急应对。在经历一个灾难后，

为了使小区适当和实时反应，此计划是至关重要的。我们强烈建议你针对风暴

对你都市林的伤害，建立一个一般性计划。对小区官方人员而言十分有用的指

南可于 Tree Emergency Plan Worksheet（L. Burban, J. Hermann, and K. Himanga）

中找到。树木管理者也可咨询 Storms Over the Urban Forest（L. Burban, J. 

Andresen）。关于两者的更多信息皆能于 i-Tree网页（www.itreetools.org）的

Resources 找到。 

 

资料收集人员（Data collection personnel） 

风暴后的资料收集主要依赖受过训练的损害评估人员。评估人员可从不同群体

招聘，取决于小区需求： 

小区工作人员 

树木专业人员 

志工 

 

所有评估人员需接受手动收集资料的训练。我们强烈建议在风暴前工作期间训

练，因为在紧急情况下训练是非常困难的。让评估人员深度熟悉估计残骸体

积、劳动时间或成本是不必要的。评估系统的设置即是为了减少对专业经验的

需求。 

 

志工通常需接受更多训练、激励和监督，使任何人在 Storm 数据收集上，皆乐

于使用志工资源。注意：为了安全起见，应小心督促参与风暴后资料收集的志

工。 

 

风暴前和风暴后的调查最好使用相同评估人员。他们应具备下列条件： 

 对树木和树木工作具一定程度的熟悉度 

 在紧急情况下的可投入时间 

 本地户籍 

 

若小区决定使用内部工作人员以建立样本样区，并向外承包实际损失评估，进

行风暴后评估的人员，需针对样区位置、数据输入和用于评估的协议程序，接

受事前训练。 

 

备份和存储（Back-up and storage） 

为风暴后的工作拟定一个弹性的计划，以有效应对不同状况。准备好面对办公

室、停电和交通意外等问题。在紧急事件期间，详细规划能减少麻烦： 
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 两个独立设置的样区信息应受维护且储存于不同位置。 

 电子设备需随时可供使用。PDA需保持充电完整，若其使用电池，则需备

好足够电池。因为灾害常会伴随停电，所以笔记本电脑作为主机会比桌

面计算机更适合。 

 数据收集的纸制表格应影印出来，且储备好铅笔、削铅笔机和剪贴板。 

 

与相关官方人员沟通结果（Communicating results with the proper officials） 

每个小区的资料汇整需实时传达给适当的官方人员，使风暴损害评估的努力能

有价值。因此，地方、州和联邦的联系方式应与风暴评估协议的信息一起归

档。可以将联系信息纪录在〈附录二〉的表格六。 

 

可以使用预先确定好的报告方式完成风暴后评估信息的传输，例如，电话、传

真、电子邮件或隔夜邮件。应建立多余一种方式，因为在大型风暴活动期间，

通信可能会受到干扰而中断。 

 

前期规划决策（Early Decisions to Be Made） 

开始执行 Storm 前，需先做出几个决定。 

 

你预估会有哪些类型的风暴？暴风雪、飓风和水灾，或规模较小的灾害？

（What kinds of storms do you anticipate? Ice storms, hurricanes and floods, 

smaller-scale disasters?） 

不同灾害类型会呈现不同的损害和残骸分布，使用 Storm 时，需再做些调整。 

 

暴风雪（Ice Storms）：暴风雪往往会造成较广泛和一致的损害，残骸几乎全是

植物。此外，冰载残骸通常会保持在其初次着陆的地方，不受自然力量四处移

动。这些特性让人透过小型随机样本快速、精确地估计潜在和实际损害与成

本。 

 

飓风和水灾（Hurricanes and floods）：飓风和许多水灾也会造成大范围的破

坏，使 Storm 产出精确的实际损害和成本之快速评估。飓风调整已内建于

Storm 里，能使用 2004-2005年内的罗里达小区于飓风季节时的 10％随机样本

实际数据和作法。针对风暴前评估，飓风调整（测试版）以街道里程数和三个

损害等级为基础，预测平均植物残骸负载。因为使用一般平均值，往往针对较

大规模的估计会比局部来得精确。 

 

更多有关估计局部规模的潜在飓风损害估计之详细方式，U.S. Army Corps of 

Engineers、佛罗里达州布劳沃德郡（Broward County, FL）的 Diana Umpierre 与

Glenn Margoles，及 FEMA 皆参与了开发。关于这些方法的更多细节，也可于 i-

Tree网站（www.itreetools.org）的 Resources 找到。 
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小型灾害（Smaller-Scale Disasters）：较小规模的灾害，包括龙卷风、derechos

（有关闪电风暴的直线型风暴）和一些水灾，会出现采样问题，因为它们影响

的区域比较小。为了估计较小规模灾害引起的损害，可使用以下程序： 

确认灾区的粗略地理位置。欲估计灾区，可能需要快速评估该区域，例如

从不同方向开车前往该区域，记录灾害开始的地方，或如果可行，利用航

空数据等。 

在街道的地图或用于采样的 GIS 档案上，绘制受影响区域的边界。 

使用比例尺地图或标准的 GIS 工具确认受影响区域的总街道里程数。 

建立该区域街道区段的合适样本。 

 

一旦完成这些调整，即可如下所述，完成暴风前的处理。 

 

飓风调整的使用者还需决定：你会于残骸移除的估计中分开树木移除和树木修

剪的估算吗？（Hurricane Adaptation users must also decide: Will you separate 

estimates for tree removal and tree pruning from estimates of debris removal?） 

数据收集协议会因你是否会在紧急工作中标出残骸（包括修剪和移除），或用不

同作法处理紧急树木修剪和/或移除，而有所差异。 

 

你会在风暴前后，或只在风暴后收集资料？（Will you collect data before and 

after or just after a storm?） 

在风暴前收集资料有几个优点。首先，你将更熟悉你的样区──它们的位置、状

态和参访它们的最佳途径。知道这些在风暴后的资料收集上会更容易。其次，

Storm 会提供预期的损害估计，帮助你做灾害准备计划。最后，对于 Storm（非

飓风）版本，暴风前的资料收集可用于改善暴风后估计。 

 

决定将残骸移除与树木修剪移除共同估计的飓风调整版本使用者，不需要做暴

风前的实地数据收集来估计损害。对于这些用户，风暴损害估计利用历史数

据，并根据城市中街道的单纯总里程数及损害的等级估计（高、中、低）。如果

你使用的是飓风调整版本，且会分开树木修剪移除跟残骸移除，包含实地资料

收集的暴风前分析也能提供有价值的信息。 

 

你的小区包含农村（无人居住）的道路吗？（Does your community include 

rural (unpopulated) roads?） 

农村道路的数据收集和人口密集区域的数据收集略有不同。这主要是因为在人

口密集区域，FEMA会补偿居民能托运到路边的残骸成本，所以超过 50 英呎的

树木会优先纳入潜在残骸的估计当中。专为农村区域和农村样区的手动表格能

由样区列表和 PDA识别。 
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收集数据，你将会使用（a）i-Tree Storm PDA 工具，（b）手动输入数据的纸制

表格，或（c）非 i-Tree平台？（Will you collect data using (a) the i-Tree Storm 

PDA tool, (b) paper forms for manual data entry, or (c) a non-i-Tree platform?） 

Storm 的软件组合包含了用于数据收集的 PDA的应用程序。i-Tree v. 3.0做出了

重大更新，现在能够使 PDA的应用从 Storm 中无缝工作。该方案能在 Pocket 

PC 的装置下，运行的Window’s Mobile 2003（或更高的版本）进行工作。 

 

如果你的团体缺少使用 PDA或行动装置的经费，或你想使用另一种方法，那也

可以。数据的收集能使用附录的纸制表格、电子表格进行。如果你使用纸制表

格，数据能在之后直接输入于 Storm 的 Excel模板中。若欲使用非 i-Tree平

台，请查看表格的数据要求。准备纸制表格是很好的想法，因为风暴可能造成

停电。 

 

收集基本资料（Gathering General Data） 

在 Storm 计算出清理的时间和金钱之前，你需提供关于你小区的几个特定数

字。 

 

你管理的所有街道的总街道里程数（Total street mileage for all of the roads you 

manage） 

确定在发生紧急情况时，你责任范围内的所有公用道路总中线里程数。这个数

字是非常重要的。如果该讯息不能立即获得，可以透过 Geography Network 

（www.geographynetwork.com）GIS 技术人员使用的 TIGER/Line 档案，免费下

载 shapefiles 档案。请参考〈附录一〉的详细讯息。 

 

透过大小类别估计修剪和移除树木的所需时间（Estimated times required for 

pruning and removing trees by size class） 

默认值可根据当地条件调整。你可以在下面的工作表中输入本地数值。 
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估计每立方码所有残骸的管理成本（Estimated cost per cubic yard for total debris 

management） 

此值包括托运、还原和最终处理的所有成本。根据 FEMA 2007 Debris 

Management Guide，Public Assistance Program 下的合格残骸工作需满足以下条

件： 

 由重大灾难事件产生的残骸。 

 残骸位于符合资格申请人的财产改善或优先权中所指定的灾难区域。 

 残骸清除是申请人的法律责任。 

欲了解更多讯息，请至：http://www.fema.gov/government/grant/pa/demagde.shtm  

 

估计每小时的树木移除率（Estimated hourly rate for tree removal） 

确定你的小区移除树木的每小时预期成本。不区分树木修剪与残骸移除的飓风

调整版本使用者应跳过这个问题。 

 

估计每小时的树木修剪率（Estimated hourly rate for tree pruning） 

确定修剪树木的每小时预期成本。不区分树木移除与残骸移除的飓风调整版本

使用者应跳过这个问题。 

 

创建样本（Creating a Sample） 

在暴风前后的资料收集开始前，你需在你的小区创建街道区段的随机样本。这

可以透过多种方式完成，其中之一在〈附录一〉有概述。任何采样方法的关键

在于，它需遵守以线性街道区段为基础的简单随机抽样常规，以提供精确的结

果。 
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我们建议创建以 2％的街道区段为样本，最少不低于 10个，最大不高于 30个

的样区。如果损伤程度相对恒定，则损害的估计被证明会落在 5％的真值中。

如有必要，选择额外的 5个区段作为替代品，也是非常好的想法。 

 

创建样本时，需仔细包括符合条件的道路，意味着你需排除私人或联邦道路。 

 

无论使用何种方法创建你的样本，最后结果应是街道区段的简单随机样本。此

外，你需知道你研究区域内的总线性街道里程数。 

 

加载或手动输入你的样本列表到 Storm（Loading or manually entering your 

sample list into Storm） 

若欲使用〈附录一〉的方法创建你的样本，你可以直接将其加载到 Storm 中，

以在在手动数据输入期间节省时间，或在 PDA使用： 

1) 使用你计算机上的开始选单 > 所有应用程序 > i-Tree > Storm > 

Storm Interface。 

2) 点击 Import from Tiger Line，浏览至保存街道区段.dbf档案的位置，

并点击 Open。 

1.  

确认样区清单是否成功建立： 

1) 在接口上点击 Add/Edit，Plot Lookup Data Entry 窗口将开启。 

2) 若欲添加更多样区，点击 New。若想改变一个样区或移除它，选取它

并点击 Edit 或 Delete。 

3) TIGER/Line 档案不包括两个你需知道的信息：ROW 宽度和样区是否

为农村（无人居住地带）。这些可以在桌机接口或实地添加。 

4) 完成样区列表后，点击 OK关闭窗口。 

 

若欲使用另一种方法创建随机样本，接口仍是输入一般样区数据到 Storm 里的

最好方式。在界面上点击 Add/Edit，再点击 New，开始手动添加样区。[请注

意：样区也可直接手动添加到 Storm 模板，可从计算机的开始选单取用。详细

信息请参考〈第二阶段〉或〈第三阶段〉的〈将数据传送至桌机〉。] 

 

将你的样本样区地图化（Mapping your sample plots） 

拥有样本样区的地图可大大简化资料收集。〈附录一〉提供了使用在 GIS 创建

的 shapefile以创建地图的说明。若你在 GIS 中使用另一种方法创建随机区段，

则该 shapefile可迭加研究区域的数字航空照片。若无法取得数字照片或样本为

手动创建，区段也可使用数字地图或纸制地图定位。 

 

PDA的准备（Preparing the PDA） 

在本节中，我们将介绍如何准备使用 PDA收集数据。若你使用纸制表格收集数
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据，你可以直接跳到下一节。 

 

PDA配置将在桌机上进行。欲开始： 

1) 使用你计算机上的开始选单 > 所有应用程序 > i-Tree > Storm > 

Storm Interface，开启 Storm Interface。 

2) 在先前的步骤中，你应该已使用接口将你的样区清单加载到 Storm

里。如果没有，请点击 Import from Tiger Line，浏览至 TIGER/Line

档案的储存位置。点击 Open。 

3) 欲将样区清单转移至 PDA，首先将 PDA链接到你的计算机。你的计

算机必需识别你的 PDA。如果无法自动识别，请依照该设备的说明完

成此步骤。 

4) 在 Storm 接口（Storm Interface）中，点击 Sync Handheld Device，

Storm PDA Transfer 窗口将开启。 

5) 你的第一步应是查看需加载哪些软件到 PDA中。请点击 Check Status

以查看。如果有任何组件缺失，它们将显示为红色，Install 按钮也会

出现。点击 Install 按钮添加必要组件，并按照 PDA屏幕上的指示操

作。 

6) 完成 PDA设置后，点击 Send Project Configuration to PDA。PDA 应

该已经准备好进行数据收集了。 

 

探索 PDA（Exploring the PDA） 

我们将在下方详细介绍 PDA应用程序，但现在，先花点时间熟悉一下它的运作

方式。欲开启应用程序，先从 PDA的程序（Program）选单中，选择 i-Tree 

Storm。在 Storm 的主选单中，点击 Next即可开始下一步。所开启的窗口将允

许你 Add Plots（新增样区）、Review Plots（检视样区）和 Delete Plots（删除

样区）。 

 

Add Plots（新增样区）是 PDA应用程序的核心。前三个窗口让你在样区上输

入（或从下拉式列表选择）一般数据。输入完样区数据后，你可选择 PreStorm 

Tallies或 PostStorm Tallies。PreStorm Tallies 允许你在 ROW 上计算树木。勾

选任何方框皆能增加计数。透过切换 Add 按钮并勾选想要的方框，可以减少或

移除一棵树。PostStorm Tallies 允许你统计需被移除或修剪的树木，其包括一

个额外窗口用于输入需移除的残骸。探索完后，点击 Back 和 Abort回到主窗

口。 

 

Review Plots 接口提供所有样区的清单。你可以点选其中一个并点击 Edit 更

改。Delete Plots接口同样提供所有样区的清单。欲删除任一条目，从列表选择

它，接着点击 Delete。 
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纸制表格的准备（Preparing Paper Forms） 

〈附录二〉（暴风版本）的表一或〈附录三〉（飓风调整）是所有样区的主选

单。传送你的样本列表到表一，包含样区数目和样区长度。如有需要，使用更

多窗体。总结所有样区的总长度。填写你的小区的总街道英里数（Total Street 

Miles）和计算街道英里百分比（Percent Street Miles）。 

 

若你将收集暴风前的数据，你需要替每个样区准备一份表二的副本。针对适用

的版本准备足够副本（如风暴或飓风； A：居住地区，B：农村地区）以涵盖

所有样本街道区段。 

 

如果你将收集暴风后的数据，你需要替每个样区准备一份表四的副本。针对适

用的版本准备足够副本（如风暴或飓风； A：居住地区，B：农村地区）以涵

盖所有样本街道区段。 

 

清单（Checklist） 

在〈第一阶段：准备〉的最后，你应已准备好以下项目： 

 打印随机样本样区的列表 

 打印样本样区的地图 

 PDA装载样本样区列表 OR。 

 所有样区皆填写完成的表一和足够的表二副本（暴风前的资料收集）或表

四副本（暴风后的资料收集）以涵盖所有样区。 

 

为了准备在风暴过后能立即收集数据，这些项目应收纳于某个安全的地方，并

应备妥副本，保留在不同位置。 
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第二阶段：暴风前（Phase II: Before the Storm） 

 

准备资料收集（Preparing for Data Collection） 

PDAs 

如果你将使用 PDA收集数据，在第一阶段中，你应该已加载你的随机样本区段

到你的 PDA。如果没有，现在回到那些步骤并仔细操作。 

 

纸制表格（Paper forms） 

如果你在第一阶段间使用纸制表格收集数据，你应该已完成了表格一、所有样

区的主要列表，以及样本街道区段足够的表二（如风暴或飓风； A：居住地

区，B：农村地区）适当版本的副本。如果没有，现在这样做。 

 

工具（Tools） 

前往实地前，你需要以下设备： 

 样本样区的地图。 

 样本样区信息的表格，包括数目、开始和结束、街道名称和长度 

 Biltmore stick 或 DBH 胶带，用于测量 DBH 或目测估算 

 手动资料收集工具 

o 表一用于追踪访问过的所有样区 

o 各样的表二区副本 

o 剪贴版 

o 铅笔（最好）或笔 

 PDA，配置完成并已装载样本样区 

o PDA保护壳，以绳挂为首选 

o 备用电池、电池组合或行动装置充电器 

o 额外的手写笔 

 

暴风前的资料收集（Data Collection Before the Storm） 

欲开始暴风前的区域调查，在地图上找到第一个街道区段的位置，并前往该区

域。 

 

测量什么（What to measure） 

在每个街道区段，你的目标是计算各 DBH 6 英吋等级的树木数量（DBH 测量

可以用 Biltmore stick、DBH胶带，或目测搭配偶尔的检查以确认其精确度）。

请记住以下限制： 

 只能计算还活着的树木。 

 只能计算 DBH ≥ 6 英吋的树木。 

 计算街道两侧与中央（若存在）的树木。 
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 在农村（无人居住）区域，计算在公共优先权（right-of-way，ROW）的树

木。 

 在人口密集区域，计算 ROW 中和 ROW 内 50英呎的树木（独立追踪它

们）。 

 如果有棵树木在 ROW边缘，如果适用，按照当地规范确定它是否为一棵

公共树。如有需要，目测树干的中间点位置，若树干的一半落入该区

域，计算它。 

 

请注意：如果不清楚精确的 ROW，基于人行道的位置、公共事业、围墙等，利

用你的实地判断计算它的边界。 

 

不需收集任何物种和条件的资料。调查的目的仅是确认任何需移除或修剪的树

木，或是经吹拂可能掉落，又或是在暴风后被拖入 ROW 的树木。 

 

测量什么：飓风调整（What to measure: Hurricane Adaptation） 

如果你正在使用飓风调整，且决定在先前的第一阶段中，从所有残骸独立追踪

树木移除/修剪，按照上述指引清点树木，但只能计算 ROW 中的树木。 

 

请注意：若你使用飓风调整版本，且你不分开追踪残骸收集与树木移除/修剪，

你便不需执行风暴前的数据收集。你可以直接跳到数据分析。 

 

手动收集资料（Data collection using manual forms） 

针对各样区，选择表二的相应版本（如风暴或飓风； A：居住地区，B：农村

地区）。填写标题讯息，包含地址数据、日期、样区长度和 ROW 宽度。如果样

区不是典型城市街区，描述样区的开始和结束。 

 

表二的主要部份允许你使用刻度标记各大小等级的树木，并在最后结算它们。

简单地走上街道区段的一边和走下另外一边，在「Tally」字段中标记每棵树木

的大小类别﹝如果可以，分开 ROW 内和 ROW 外（ROW + 50）的树木﹞。完

成该区段后，计算你的刻度标记数量，在下一字段内写下数字。 

 

使用 Storm 模板时，表二的其余区域会自动计算。如有必要，依循表格下方的

说明，它们也可手动计算。 

 

使用 PDA收集数据（Data collection using the PDA） 

欲使用 PDA开始收集数据： 

1) 从 PDA中的应用程序（Programs）选单选择 i-Tree Storm。 

2) 在主窗口点击 Next，准备开始。 

3) 点击 Add Plot，输入 Community name，从下拉式选单中选取一个样



20 

区。欲添加不在清单上的样区，直接填写下方字段。点击 Next。 

4) 输入 ROW width（ROW 宽度），再于 Collected By 下输入你的名字或

名字缩写，点击 Next。 

5) 如果区块非典型市区，输入样区开始与结束的描述。 

6) 点击 PreStorm Tallies，开始计算树木。 

a) 走上街道区段的一侧，并从另一边走下，勾选适当大小等级的

方框，将树木添加至 ROW 中。 

b) 如果你犯了一个错误，需要移除树木，点击 Add/Subtract

钮，切换至减除，接着点击删除。 

c) ROW 树木添加完成后，如果没有问题，点击 Next，针对 Off 

ROW 树木重复以上步骤。 

7) 完成后，点击 Save Tallies保存你的数据。 

8) 回到主选单继续添加样区。 

 

存档后，若你需要编辑一个样区，在主选单中点击 Review Plots，选择要编辑

的样区，点击 Edit 进行变更。 

 

将数据传送到桌机（Transferring Data to the Desktop） 

PDAs 

从你的 PDA传送 PDA 收集的普查数据到你的桌机上： 

1) 连接 PDA到你的计算机。 

2) 在你的计算机中的开始选单，打开 Storm PDA Interface。 

3) 点击 Sync Handheld Device，选择 Retrieve Data from PDA。 

4) 点击 OK关闭窗口。你的普查数据已上传到 Storm。 

5) 点击 Export Data to Spreadsheets。 

6) The Community Values 窗口将开启，让你输入在〈第一阶段：准备〉

时确定的数值。输入当地成本和预估时间后，点击 OK。 

7) Save File窗口将开启，浏览至欲储存档案的位置，替你的项目文件命

名，点击 Save。你的档案将保存到 Storm 模板（Excel 文件）。 

8) 执行 Excel 并开启你在上一步骤中创建的档案。同意 Enable macros。 

 

纸制表格（Paper） 

从纸制表格转传数据到 Storm： 

1) 在你的计算机的开始选单中，打开 Storm PDA Interface。 

2) 在〈第一阶段：准备〉时，你应该已加载或手动输入你样的区名单到

Storm Interface 中。如果没有，现在进行此步骤，点击 Import from 

Tiger，浏览至样本样区的.dbf档案，或点击 Add/Edit 手动输入样区数

据。 

3) 添加完所有样区后，点击 Export Data to Spreadsheets。 
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4) The Community Values 窗口将开启，让你输入在〈第一阶段：准备〉

时确定的数值。输入当地成本和预估时间后，点击 OK。 

5) Save File窗口将开启，浏览至欲储存档案的位置，替你的项目文件命

名，点击 Save。你的档案将保存到 Storm 模板（Excel 文件）。 

6) 执行 Excel 并开启你在上一步骤中创建的档案。同意 Enable macros。 

7) 在主屏幕上，从 Select Analysis 下拉式选单中选择暴风（Storm）或飓

风（Hurricane）。 

8) 现在，跳过主屏幕上的剩余问题，点击 Excel 底部的 PreData tab。 

9) 每一行包含一个样本样区的数据。在模板上，将样区编号与表二副本

的样区匹配，接着将表二的主选框中的数据传输到电子表单上的合适

区块。 

a) 若有需要，你可以透过选择最上面一行的所有区块（通常为

O1: AB1），再于 Excel 主要工具栏中，点击 Data > Form，在

Excel 上创建一个输入表格，使数据输入更加方便。点击 Tab

键在字段间移动，点击 Enter键移动到一个新的纪录。 

b) 请记得经常储存你的工作进度。 

 

资料分析（Data Analysis） 

设置问题（Set-up questions） 

当你的数据手动或使用 PDA接口输入完毕后，你即可开始数据分析。如有必

要，可以透过先前步骤中储存的 Excel 档案，开启 Storm 模板。同意 Enable 

macros。 

 

如果你使用飓风调整，就不需收集暴风前的资料，因为你将修剪和移除一起算

入残骸收集里。在这个步骤中，你可以从你计算机开始选单中开启 Storm 模

板，重新命名并另存在你想要的位置上。 

 

确认上方的分析选项（暴风与飓风）是正确的。与当地成本和时间估算有关的

问题 1-4和最后问题（5为飓风，8为暴风）的答案，应照你输入至接口的数据

填写。如果没有，或你想进行更改，根据你在〈第一阶段：准备〉所收集到的

信息回答问题。 

 

飓风调整的问题 5询问你想使用的残骸率。这个选择只影响风暴前的计算，和

风暴预期严重程度有关。你可以在三个值之间切换，并观察结果如何变化。欲

开始，请保留预设中间值。 

 

若你使用的是暴风版本（非飓风），你可以对问题 5-7提供更多信息，或你也可

以将它们标记为「Unknown（未知）」。对这些问题的回答有助于确定结果的精

确度。 
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问题 5：你的树木密度号码的来源是什么？Storm 利用树木密度的平均值估计被

制造的粗材残骸量，无论是针对暴风前的估计，或为了将树冠缺失量转化成残

骸的立方码。默认值来自下表a： 

 

 
 

对于高阶的用户，默认值可在 Storm Excel 模板的 Codes tab 下进行调整。若你

改变数值，针对问题 5选择一个最能描述你的方法的回答。对大多数的用户来

说，他们都会想保留默认值。 

 

问题 6：你用什么抽样方法？从下拉选单选择最合适的答案。 

 

问题 7：你是如何得到你的暴风前信息？对暴风前资料分析留下未知

（unknown）。 

 

报告（Reports） 

回答所有问题后，点击 PreAnalysis 标签查看你的暴风前估计。灰色框包含你在

主屏幕上输入的信息。树木的号码是从 PreData所编码。重要的数值──劳动时

间、总成本和全部残骸──都在右上角。最重要的数字，重大暴风损害的暴风前

预估，显示于最上方的紫色方框。 

 

打印（Printing） 

在 Excel 工具栏里，点击档案（File）> 打印（Print）。报告已设定好将打印最

重要的信息：结果、移除（Removals），以及危险修剪的计算。 

 

                                                 
a 關於如何創建此表的更多資訊，請參考 i-Tree 網站（www.itreetools.org）的 Resources 的

〈An Initial Storm Damage Assessment Protocol for Urban and Community Forests〉。 
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第三阶段：暴风后(Phase III: After the Storm) 

一旦风暴安全通过，资料收集应尽快开始，且应在风暴结束后的 12小时内完

成。 

 

准备资料收集（Preparing for Data Collection） 

PDAs 

如果你将使用 PDAs 收集数据，在第一阶段你应已加载你的随机样本区段到你

的 PDA了。如果没有，现在回到那些步骤并开始处理。 

 

纸制表格（Paper forms） 

在第一阶段，你应该已完成了表一、你所有样区的主列表，并已准备足够兼容

版本的表格三之副本以用于你所有的样本街道区段（如，A：居住区域、B：乡

村区域；飓风或暴风）。如果没有，现在开始进行。 

 

工具（Tools） 

前往实地前，你需要以下设备： 

 样本样区的地图。 

 样本样区信息的表格，包括数目、开始和结束、街道名称和长度 

 Biltmore stick 或 DBH 胶带，用于测量 DBH 或目测估算 

 手动资料收集工具 

o 表一用于追踪访问过的所有样区 

o 各样的表二区副本 

o 剪贴版 

o 铅笔（最好）或笔 

 PDA，配置完成并已装载样本样区 

o PDA保护壳，以绳挂为首选 

o 备用电池、电池组合或行动装置充电器 

o 额外的手写笔 

 

安全（Safety） 

在都市环境中收集数据时，安全总在考虑之内，都市环境标准预防措施应被采

用。当然，在风暴过后，数据收集的风险更大，因为 Storm 程序需在风暴通过

后的 12 小时内调查样本样区。透过手机、双向无线电或其它方法，与当地风暴

中心或危机协调员建立可靠的联络方式，以及一台可依赖的车子（在冬天风暴

情况下需有四轮驱动）为宜。 

 

大灾害等级的风暴往往会产生危险的状况。危险的树木及树木部分可能威胁道

路与人行道。这些包括树冠上的大型悬挂物体、已经不稳定的整棵树木以及地
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面上的大量残骸。此外，被放低或被击落的电线常会落在与人容易接触的地

方。由于它们经常还有作用，风暴过后的资料收集者需警戒并远离它们。与当

地公共事业官员的仔细协调将有助于降低资料收集者的风险。 

 

请注意：你应遵照先前规划的样区之间的有效路径，但当规划的路线被阻碍

时，也要准备好使用其他路线。移动可能会被残骸或击落的电线所限制，使得

进行调查变得困难与危险。要对危险有所警觉。这里详述的收集方法可能在一

些样区上会有修改以保障安全。无论何时进行修改，都应谨慎进行，并尽可能

维持数据质量，让最后的估算有一定准确度。 

 

暴风后的资料收集（Data Collection After the Storm） 

首先，在地图上确定第一个街道区段（样本样区），之后前往该地。 

 

测量什么（What to measure） 

在风暴过后的数据收集中，有三个关键信息需被记录（针对飓风调整，你可能

已决定将这些分于同一组中）： 

 需移除的树木的数量及大小。 

 需修剪以移除危险树枝的树木的数量与大小。 

 生成的残骸量 

 

需移除的 ROW树木：在 ROW 中计算树木数目及大小，包括以下： 

 树木部分倒下（例如树木部分被连根拔起或靠在其它树木上）。如果树木有

任何部份落于或可能倒塌到 ROW 范围内，此树应被计数。 

 树冠有明显损伤（失去 50%或更多树冠），但仍屹立不倒的树木也包含在移

除内，因为 FEMA 将允许这些费用。不过良好的判断标准也应被执行。

研究和经验表示一些品种针对其失去的大量树冠恢复得十分良好，健

康、年轻的树木有很好的恢复机会，且距离主干树冠越远的失去对树木

的威胁越小。 

 不包含已完全倒在地面的树木。这些应作为残骸估计移除。 

 只有 ROW 树木应包含在内。 

 

请注意：如果无法得知准确的 ROW，根据实地状况判断，像是人行道、公共设

施、栅栏的位置等，以估计其边界。 

 

需修剪以移除危险树枝的 ROW树木：记录有破碎或悬挂树枝的树木的数量及

大小，其树枝直径是两吋或更大，且仍在树木的树冠上。请注意，危险修剪会

仅限移除悬挂或破碎的树枝。额外的修剪如修正撕开的树枝或将破碎的树枝适

当修剪并不包含在内。只有 ROW 树木应被包括在内。 
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产生的残骸量：纪录 ROW 内的生成且需移除之残骸量（针对居住区域，与

ROW 距 50英呎的区域也算在内）。这可以两种方法计算： 

 

树冠损失：针对你行道区段的每 100英呎，估计所有 DBH ≥ 6英吋且位于

ROW 内的树木树冠损失量（针对居住区域，与 ROW 距 50英呎的区域也

算在内）。估计应为 25%阶级的中点，即为 12.5%（0-25%树冠损失）、

37.5%（26-50%树冠损失）、62.5%（51-75%树冠损失）或 87.5%（76-100%

树冠损失）。有关更多估计树冠损失的信息，请参考 i-Tree网站

（www.itreetools.org）的 Resources 内的相关文件。 

 

请注意：如果结构以及拆卸的残骸还存在，此树冠损失选项不能用于估计残

骸。因此，此种方法不适用于飓风调整。 

 

立方码（Cubic yards）：针对你行道区段的每 100英呎，估计 ROW 内的实

际残骸体积（针对居住区域，与 ROW 距 50英呎的区域也算在内）： 

想象一个装入残骸的箱子。如果是零散的，把它们想象在一起。 

以英呎估计箱子的长度、宽度以及高度。 

将这些尺寸相乘并除以 27以转换到立方码。 

例如：一个典型的 100英呎延伸可能有 50英呎的 ROW 到任一侧的中

线，并完全被残骸覆盖到高 2英呎，使该公式： 

100 ft（长）x 200 ft（宽）x 2 ft（高）= 40,000 ft3 ÷ 27 = 1,480 yds3 

 

测量什么：飓风调整(What to measure：Hurricane Adaptation) 

如果你使用 Storm 的飓风调整版本，你收集的数据取决于你是否决定分开估计

树木移除修剪及残骸的成本。如果你分开估计移除修剪，只要遵照上方的指示

并且确定使用立方码方法计算残骸量。 

 

如果你合并计算移除修剪和残骸，遵照上方的立方码方法的指示，计算残骸的

移除。 

 

手动收集资料（Data collection using manual forms） 

针对各样区，请选择适合样区类型的表格四版本（A：居住区域，B：乡村区

域；飓风或暴风）。填写标题信息，包括地址数据、日期、样区长度及 ROW 宽

度。如果样区非完整街区，请描述样区的启始与末端。 

 

表格四的主要部分允许你使用刻度标记各大小等级的树木，并在最后结算它

们。简单地走上街道区段的一边和走下另外一边，在「Tally」字段中标记每棵

需移除与需修剪的 ROW 树木的大小类别。完成该区段后，计算你的刻度标记

数量，在下一字段内写下数字。接着，使用树冠损失或立方码方法估算每延伸



26 

100英呎需移除的残骸量，并在最后两栏输入数值。如果有个区段的延伸超过 8

个 100英呎，则估算剩余的每 100英呎区段平均值，并在「额外（Extra）」字

段输入。 

 

表格四的剩余项目，包括总合与平均数，将自动使用 Storm 模板计算。如有需

要，它们也可手动计算，只要遵照表格底部的指示。 

 

使用 PDA收集数据（Data collection using the PDA） 

欲使用 PDA开始收集数据： 

1) 从你的 PDA程序（Program）选单选择 i-Tree Storm。 

2) 在主窗口中点击 Next 以开始执行。 

3) 点击 Add Plot，输入 Community name 并从下拉式清单中选择样区。欲

添加不在清单上的样区，直接填写下方字段。 

4) 点击 Next。输入 ROW width（宽度），在 Collected By 输入你的名字或

名字缩写。点击 Next。 

5) 如果此区段非完整街区，请描述此样区的开始与结束。 

6) 点击 Post Storm Tallies 开始计算树木。第一个窗口是需修剪的相符树

木。简单地走上街道区段的一边和走下另外一边，在适当的大小类别中

点击字段以计算需要修剪的 ROW 树木。如果你犯了一个错误且需删除

树木，点击 Add/Subtract 按钮，切换到减少，再点击删除。 

7) 一旦需修剪的树木已被添加，点击 Next进入到危险移除（Hazard 

Removal）窗口，计算需移除的树木。 

8) 最后，点击 Next估计残骸移除。你可以藉由点击上方的按钮以在立方码

与百分比树冠损失间切换。 

9) 完成后，点击 Next与 Save Tallies 以储存你的数据。 

10) 回到主要选单继续添加样区。 

 

如需编辑已储存的样区，在主选单中点击 Review Plots，选择欲编辑的样区，

点击 Edit 以进行变更。 

 

将数据传送到桌机（Transferring Data to the Desktop） 

PDAs 

欲将你使用 PDA收集的普查数据传送到你的桌机： 

1) 将 PDA连接到计算机。 

2) 从你计算机的开始选单中开启 Storm 的 PDA接口。 

3) 点击 Sync Handheld Device，再点击 Retrieve Data from PDA。 

4) 点击 OK以关闭窗口。你的普查数据现在已经上传到 Storm 了。 

5) 点击 Export Data to Spreadsheets。 

6) The Community Values 窗口将开启，允许你输入你在〈第一阶段：准
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备〉时所确定的数值。输入完你的当地成本与估算时间后，点击 OK。 

7) Save File窗口将开启。浏览至你想要储存档案的地方，命名项目后，点

击 Save。你的数据已经保存到 Storm 模板了（一个 Excel 文件）。 

8) 开启 Excel 并开启你在上一步所建立的文件。同意 Enable macros。 

 

纸制表格（Paper） 

从纸制表格转传数据到 Storm： 

1) 在你的计算机的开始选单中，打开 Storm PDA Interface。 

2) 在〈第一阶段：准备〉时，你应该已加载或手动输入你样的区名单到

Storm Interface 中。如果没有，现在进行此步骤，点击 Import from 

Tiger，浏览至样本样区的.dbf档案，或点击 Add/Edit 手动输入样区数

据。 

3) 添加完所有样区后，点击 Export Data to Spreadsheets。 

4) The Community Values 窗口将开启，让你输入在〈第一阶段：准备〉

时确定的数值。输入当地成本和预估时间后，点击 OK。 

5) Save File窗口将开启，浏览至欲储存档案的位置，替你的项目文件命

名，点击 Save。你的档案将保存到 Storm 模板（Excel 文件）。 

6) 执行 Excel 并开启你在上一步骤中创建的档案。同意 Enable macros。 

7) 在主屏幕上，从 Select Analysis 下拉式选单中选择暴风（Storm）或飓

风（Hurricane）。 

8) 现在，跳过主屏幕上的剩余问题，点击 Excel 底部的 PreData tab。 

9) 每一行包含一个样本样区的数据。在模板上，将样区编号与表四副本

的样区匹配，接着将表四的主选框中的数据传输到电子表单上的合适

区块。 

a) 字段 A-O应会自动填入，使用你输入的样区信息或上传到

Storm 接口的信息。 

b) 字段 P-V标记为 HzPrnXX，XX代表不同的大小类别，在每个

类别填进需要危险修剪的树木数量。 

c) 字段 W-AC 标记为 RemvXX，在每个大小类别填进需移除的树

木数量。 

d) 字段 AD会标记 CY，如果你使用立方码测量残骸，输入 Y，

若你使用树冠损失方法，输入 N。 

e) 尽管字段 AE-AV标记为 CanopyLoss，它们应被用于输入残骸

估计，使用任一方法（树冠损失或立方码）。在每个字段输入

各 100 英呎区段的残骸量。如果你在表格三的额外字段有数

值，使用 AN（CanopyLoss10）。 

f) 字段 AO及 AP（AvgCanopyLoss 与 Cytotal）将自动计算。 

g) 你可以在 Excel 中建立一个输入格式使数据输入更加容易，选

择所有需要的字段的第一行（通常为 P1: AN1）选择，并在
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Excel 的主要工具栏中点击 Data > Form。点击 Tab 键以在字

段间移动，点击 Enter键以移动到新纪录。 

h) 请记得经常储存你的工作进度。 

 

资料分析（Data Analysis） 

设置问题（Set-up questions） 

当你的数据手动或使用 PDA接口输入完毕后，你即可开始数据分析。 

 

如果你仍遵照着这些指示，你应在 Storm Excel 模板中了。如果没有，请开启你

在在上一步骤储存的 Excel 档案。确认上方的分析选项（暴风与飓风）是正确

的。 

 

与当地成本和时间估算有关的问题 1-4和最后问题（5为飓风，8为暴风）的答

案，应照你输入至接口的数据填写。如果没有，或你想进行更改，根据你在

〈第一阶段：准备〉所收集到的信息回答问题。 

 

飓风调整的问题 5询问你想使用的残骸率。这个选择只影响风暴前的计算，和

风暴预期严重程度有关。 

 

若你使用的是暴风版本（非飓风），你可以对问题 5-7提供更多信息，或你也可

以将它们标记为「Unknown（未知）」。 

 

问题 5：你的树木密度号码的来源是什么？Storm利用树木密度的平均值估

计被制造的粗材残骸量，无论是针对暴风前的估计，或为了将树冠缺失量

转化成残骸的立方码。默认值来自下表a： 

 

 

                                                 
a 關於如何創建此表的更多資訊，請參考 i-Tree網站（www.itreetools.org）的 Resources的

〈An Initial Storm Damage Assessment Protocol for Urban and Community Forests〉。  
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对于高阶的用户，默认值可在 Storm Excel 模板的 Codes tab 下进行调整。若你

改变数值，针对问题 5选择一个最能描述你的方法的回答。对大多数的用户来

说，他们都会想保留默认值。 

 

问题 6：你用什么抽样方法？从下拉选单选择最合适的答案。 

 

问题 7：你如何得到你的风暴后信息？从下拉式清单中选择最适合的答案。 

 

完全手动选项（Completely Manual Option） 

在某些情况下，由于停电或难以到达，你可能无法完全使用你的计算机。在这

种情况下，你可以使用表格三及六手动计算，遵照在每页底部的指示。 

 

报告（Reports） 

回答所有问题后，点击 PostAnalysis 标签查看你的暴风前估计。灰色框包含你

在主屏幕上输入的信息。树木的号码是从 PostData所编码。重要的数值──劳动

时间、总成本和全部残骸──都在右上角。最重要的数字，重大暴风损害的成本

预估，显示于最上方的黄色方框。 

 

打印（Printing） 

在 Excel 的工具栏中，点击档案（File）> 打印（Print）。此报告将设置为打印

最重要的讯息：结果、移除与危险修剪计算。 
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附录一：随机样本工具书（Appendix 1: Random 

Sample Workbook） 

以下指示将帮助任何专业程度的人员创建随机 i-Tree Storm 样本街段，用于实地

资料收集。ESRI ArcGIS 软件将被使用（只需些微调整的操作指示与 ArcGIS v. 

8兼容）举例来说，美国人口普查的 TIGER 地图数据被应用于整个城市。如欲

使用于单一城市区域，请遵循各区域的基本指示。 

 

这些指示由两个基本步骤组成： 

1) 准备项目区域数据。 

2) 产生样本街段。 

 

完成上述步骤后，你已创建了下列： 

 关注区域的多边形（polygon）地图图层 

 随机街段线性（line）地图图层 

 

提示： 

 这些指令需在 ArcView 级别下使用 ArcGIS 的基本功能。无须使用任何扩

充软件。 

 进阶 GIS 使用者可主要关注下方列点条列的准备步骤概观，特别注意区域

名称与类型等区域的细节指示。 

 对于拥有 Spatial Analyst 的进阶 GIS 使用者：迭加 AOI分区图层以裁切

AOI边界的街道。针对区域为基础的分析，在创建一个随机样本街段的

图层后，将之与一个区域多边形图层组合，以将街段依区域边界分割。 

 若有需要，从地图记录提供者取得投影/坐标系统与地图单位信息。 

 AOI样本为大型多边形，如城市边界、公园区域或者是个别管理区。 

 ESRI shapefiles、覆盖或地理普查皆可使用。Shapefiles 非常容易上手。 

 建立良好的数据管理习惯：放置原始数据的文件夹、放置导出数据的文件

夹、有逻辑地命名文件夹等。 

 定期地在完成步骤期间，将你的作业保存为 ArcGIS *.mxd 专案。 

 下载数据时，你可能需关闭网页浏览器中的弹跳窗口。 

 

常用工具（Common tools）： 

 

开启项目（Open Project） 

 

选取（Select） 
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添加资料（Add Data） 

 

 

项目区域数据准备（Project Data Preparation） 

概观（Overview）： 

 取得可呈现你项目的多边形关注区域（AOI）的 GIS 地图图层。 

 取得可呈现你项目的街道中心线的 GIS 地图图层。 

 在 ArcView、ArcEditor 或 ArcInfo级别下启动 ArcGIS 中的 ArcMap 应用程

序。 

 保存一个*.mxd 项目文件，并选择名称和档案位置。 

 加载 AOI和街道地图图层到视图中。 

 如有需要，选择最能代表你项目区域的特定多边形 AOI。 

 汇出选定的多边形 AOI。 

 如有需要，选择（或剪下）你 AOI中的街道线。 

 汇出所选择的街道线。 

 

结果（Results） 

 由一个或多个多边形组成的 AOI地图图层。 

 相关街道线地图图层。 

 

 

详细说明（Detailed instructions） 

1) 从你的 GIS 部门或是在线资源网，例如 ESRI’s 地理网

（www.geographynetwork.com/）取得你的 AOI多边形： 

a) 欲取得美国普查 TIGER 地图数据，于网络浏览器浏览到

Geography Network。你可能需要在你的网络浏览器关闭任何

的弹出窗口。 

b) 在 Featured Content 下选择 Census TIGER/2000。 

c) 点击 TIGER/Line Files, Redistricting Census 2000。 

d) 选择 Preview 及 Download。 

e) 在 Select a State 下选择你的州别；点击 Submit Selection。 

f) 在 Select by County 下选择你的郡县；点击 Submit 

Selection。 

g) 在 Available Data Layers 下，勾选以下两个文件旁的选框

（box）： 

Designated Places 2000 

Line Features – Roads 

h) 选择 Proceed to Download；选择 Download File。 
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i) 将文件保存到磁盘并解压缩到你的工作目录或是其它位置，使

你可以轻松找到。 

2) 在 ArcView（或 ArcEditor或 ArcInfo）等级下启动 ESRI’s ArcMap 应用

程序。 

3) 使用 Add Data 浏览并加载 TIGER Designated Places 以及 Line Features 

– Roads 地图层到当前视图。如果出现一个「未知空间参考（Unknown 

Spatial Reference）」讯息，请点击 OK以前往下一步。 

4) TIGER Designated Places 数据通常是由县组织并经常包括多个地点多边

形。在屏幕上使用 Select工具，选择你的特定 AOI多边形。如有需要，

细读属性表或使用特色卷标（Feature labeling）功能帮助你辨识 AOI多

边形。 

5) 输出选择的 AOI多边形到一个分离的地图层，并添加输出层到视图中： 

a) 在 TIGER Designated Places 地图层上点击右键，选择 Data > 

Export Data 

 

 
 

b) 确认 Export下拉式选单已设置到 Selected features。 

c) 为 AOI多边形地图命名并储存。 

d) 系统提示时，点击 Yes 以将输出数据作为一个地图层添加到视

图中。 

6) 查询 TIGER Road Lines 地图图层以选择适合的街道区段为样本： 

a) 在 Table of Contents（TOC）地图图层清单中，点击 Road 

Lines 地图图层以选择它（确认该地图图层也在 TOC 中被选取
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且因此可见于地图中）。 

b) 从主要工具栏中，选择 Selection > Select by Attributes。 

 

 
 

c) 在开启的对话窗口中： 

确认 Road Lines 已在下拉式选单中被选择 

确认所选择的方法是设置为 Create new selection 

在窗口底部的查询框内复制贴上已下查询信息： 

(“CFCC” = ‘A21’) 

(“CFCC” = ‘A25’) 

(“CFCC” = ‘A31’) 

(“CFCC” = ‘A35’) 

(“CFCC” = ‘A41’) 

(“CFCC” = ‘A45’) 

 

 
 

7) 在选择的街道上执行额外的查询，以确定那些在输出的 AOI内： 

a) 在 Table of Contents（TOC）地图图层清单中，点击 Road 

Lines 地图图层以选择它（确认该地图图层也在 TOC 中被选取
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且因此可见于地图中）。 

b) 从主要工具栏中，选择 Selection > Select by Location，在之后

开启的窗口中： 

在 I want to 的下拉式选框中，选择 select from the 

currently selected features in。 

确定只有 TIGER Road Lines 图层在 the following 

layer(s)清单中被选取。 

在 that下拉式选框中，选择 are within （选项

completely within 不适用此操作）。 

确定之前汇出的 AOI多边形层在 the features in this 

layer下拉式选框中被选取。 

不要缓冲（buffer）AOI多边形。 

点击 OK。 

 

 
 

8) 汇出所选的 TIGER Road Lines 之子集到一个分开的地图图层，并添加此

图层到视图中： 

a) 在 TIGER Roads Lines 地图图层上点击右键，选择 Data > 

Export Data。 
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b) 确认 Export下拉式选单已设置到 Selected features。 

c) 为选择的 streets line地图层命名并储存。 

d) 当系统提示时，点击 Yes 并将导出数据作为一个地图图层添加

到视图中。 

从主要工具栏中，选择 Selection > Clear Selected Features 以取消选择 AOI多

边形和街道特色（Streets features）。 

 

 
 

 

结果（Results） 

AOI 多边形地图图层，以及相关的、适合作为样本的 AOI街道线性图层。 

 确认 AOI多边形和街道地图图层已加载到地图视图中。可能需要在新 AOI

图层点击右键并选择 Zoom to Layer。 

 在地图层清单中右键点击新 AOI图层的名称，选择 Open Attribute Table

以确认使用属性字段（例如「名称」）的是正确的 AOI多边形。 

 确认 street lines 没有延伸并通过 AOI多边形。 

 

 
 

这条 street lines 现在已经准备好采样了。 

 

 

生成街道区段样本（Street Segment Sample Generation） 
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概观（Overview） 

 添加一个区域到街道数据里。 

 计算街道数据的随机数目数值。 

 从属性栏选取期望的街道区段样本数目。 

 导出街道样本数据和地图。 

 

结果（Results） 

 供实地采样的随机街道区段。 

 

 

详细说明（Detailed instructions） 

1) 在裁切过的 Streets 地图图层中，右键点击 TOC中的 layer name开启表

格。 

2) 使用表格窗口左上角的 Options 按钮，添加一个 Double类型、名为

RandomSeg 的字段至裁切完成的 Streets 表格。将 Precision 和 Scale 字段

留空。 

 

 
 

3) 右键点击新建的 RandomSeg 字段标题，并使用 Field Calculator使用

RND函数填满字段： 
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4) 填满字段后，鼠标右键点击 RandomSeg 字段标题，按照升序排序字

段。 

5) 滚动属性栏至街道区段的期望数目并选取之： 

a) 点击栏目中的任一单元格以检视 Record count box 的记录

数目。 

 

 
 

b) 找到期望的记录数目后，按住 Shift键，同时使用记录条目

左侧的灰色钮选取记录。 

 

 
 

6) 关闭表格窗口并返回至地图窗口，导出选定的 Streets 地图图层样本，并

将它们添加到窗口里： 

a) 鼠标右键点击已裁切的 Streets 地图图层，并选择 Data > 

Export Data。 
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b) 确认 Export下拉式选单已设置为 Selected features。 

c) 将所选的 Streets 地图图层命名并保存。 

d) 系统提示时，点击 Yes 将导出的数据添加为地图图层到窗

口中。 

7) 从主要工具栏中，选择 Selection > Clear Selected Features 取消选取街道

特色（Streets feature）。 

8) 如有需要，开启新创建的街道样本属性栏，并导出记录供Microsoft 

Excel 使用（用于打印等）： 

a) 点击 Attribute表格 > Options 按钮 > Export > All 

records。 

b) 选择汇出为一个 dBase 档案，其可用于MS Excel。 

9) 如有需要，打印街段地图以供规划和现场使用： 

a) 在地图窗口中，以名称字段标签街段。 

b) 鼠标右键点击 TOC 上的标注以重新着色地图图层，改善其

视觉观感。 

 

 
 

c) 切换到 Layout 视图，并透过上方的 Insert选单添加地图元

素，例如指北针与比例尺。 

 

 
 

d) 从主要工具栏中，选择 File > Print，并选择合适的打印机

和纸张。 
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e) 非必要选项（Optional）：选择 File > Export Map 保存地图

的电子副本。 

10) 非必要选项（Optional）：对于 AOI中的区域，添加区域多边形图层。为

了让各区域街道样本数量相符，使用 Select by location 功能。 

 

结果（Results） 

在 LINE的地图图层中，随机街段样本的期望数目。 

街段样本属性数据的 MS Excel 文件。 

纸本化或电子化的样本区段地图。 
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附录二：数据表格──暴风（Appendix 2: Data 

Forms—Storm） 

本附录包含所有需用于暴风前收集数据或暴风后使用常规暴风协议表格（非飓

风适用）的表格。 

 

表格一（Form 1）：记录样区长度及暴风结束前后的调查 

表格二 A（Form 2A）：暴风前的实地数据收集表（居住区域）。 

表格二 B（Form 2B）：暴风前的实地数据收集表（乡村区域）。 

表格三（Form 3）：暴风前的小区总资料。 

表格四 A（Form）：暴风后的实地数据收集表（居住区域）。 

表格四 B（Form 4B）：暴风后的实地数据收集表（乡村区域）。 

表格五（Form 5）：暴风后的小区总资料。 

表格六（Form 6）：地方、州与联邦机构联络信息。 

 

﹝请注意：表格的三和五所描述的计算会在暴风模型中自动生成。这里提

供表格仅供你参考并在紧急情况下完成手动计算。﹞ 
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附录三：数据表格──飓风（Appendix 3: Data 

Forms—Hurricane） 

本附录包含所有需要用于暴风前后使用飓风调整的数据收集表格。 

 

表格一（Form 1）：记录样区长度以及暴风结束前后的调查。 

表格二 A（Form 2A）：暴风前的实地数据收集表（居住区域）。 

表格二 B（Form 2B）：暴风前的实地数据收集表（乡村区域）。 

表格三（Form 3）：暴风前的小区总资料。 

表格四 A（Form）：暴风后的实地数据收集表（居住区域）。 

表格四 B（Form 4B）：暴风后的实地数据收集表（乡村区域）。 

表格五（Form 5）：暴风后的小区总资料。 

表格六（Form 6）：地方、州与联邦机构联络信息。 

 

﹝请注意：表格三和五所描述的计算会在暴风模型中自动生成。这里提供

表格仅供你参考，并在紧急情况下手动完成计算。﹞ 
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